
WELCOME TO PGSS™

• What is PGSS™?

PGSS™ is a personal golf score management program, designed to provide an
informative statistical record of your performance on the links. Once a PGSS™ file for
a course has been created, you just enter your scores and PGSS™ does the rest.

In addition to allowing you to save, sort, and view individual scorecards (up to
500 per course file), PGSS™:

— Compiles  and displays  a  distribution  of  your  scores  in  terms  of  eagles,
birdies, pars, bogeys, double bogeys, triple bogeys, and others. It does this
for each hole, the front and back nines, and the entire course.

— Calculates and displays your scoring average for each hole, the front and
back nines, and the entire course.

— Determines and displays your high and low scores for each hole, the front
and back nines, and the entire course.

— Computes and displays the amount by which you play each hole, the front
and back nines, and the whole course over or under par.

By selecting items from the PGSS™ menu bar, you can also get the following
information:

— An index of the scorecards in your course file, based on the order in which
they are currently sorted.

— An analysis of an individual round, broken down in terms of the number of
eagles, birdies, pars, bogeys, double bogeys, triple bogeys, and others you
scored on par 3s, par 4s, and par 5s.

— An analysis of your scoring on the course, broken down in terms of the
number  and  percentage  of  eagles,  birdies,  pars,  bogeys,  double  bogeys,
triple  bogeys,  and  others  you  scored  on  par  3s,  par  4s,  and  par  5s.  In
addition, the amount by which you play each kind of hole over or under par
is calculated and displayed.

— A distribution of your scores for individual holes, the front or back nines, or
the entire course, including the dates on which you last shot a particular
score.

— A sorted ranking of the holes of a course in terms of their difficulty, i.e., how
much you play them over or under par.

— A sorted ranking of the holes of a course in terms of the percentage with
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which you eagle, birdie, par, bogey, double bogey, triple bogey, or other
them.

— A summary of up to fifty of your previous rounds on a course, displaying
your scoring distribution,  scoring average,  high and low scores,  and par
differential on a hole-by-hole and total basis.

To assist you in finding a particular scorecard, PGSS™ allows you to sort your
cards by entry order, by date, or by your score on individual holes, the front nine, the
back nine, or the entire course. In addition, other menu items let you quickly find the
following:

— The scorecards containing your high and low scores for the front nine, back
nine, or entire course.

— The scorecards for the rounds in which you scored the most eagles, birdies,
pars, bogeys, double bogeys, triple bogeys, or others.

— The scorecards for the rounds in which you scored the most consecutive
eagles, birdies, pars, bogeys, double bogeys, triple bogeys, or others.

— The scorecards for the rounds in which you had the most holes over eagle,
birdie, par, bogey, double bogey, or triple bogey.

— The scorecards for the rounds in which you had the most holes under birdie,
par, bogey, double bogey, or triple bogey.

— The scorecards for the rounds in which you had the most consecutive holes
over eagle, birdie, par, bogey, double bogey, or triple bogey.

— The scorecards for the rounds in which you had the most consecutive holes
under birdie, par, bogey, double bogey, or triple bogey.

— The scorecards which match a particular pattern of scoring you select and
enter.

PGSS™ will also allow you to print your scores, along with your distribution
and scoring averages.

• What are the system requirements of PGSS™?

PGSS™ was written using THINK Pascal™ on a beige-colored Macintosh Plus
with 4MB of RAM, using Systems 6.0.5 through 6.0.8.  It  is  now running without
incident on a cache-enabled Quadra 610 with 12MB of RAM, using System 7.5.1 in
32-bit mode. I am aware of no reason why it shouldn’t operate on any intermediate
configuration. If problems are experienced, however, please contact me and — if you
are a registered owner — I will do my best to correct them. Aw, hell, I’ll try and fix
‘em even if you aren’t registered. 
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There are two versions of PGSS™ available. The first — PGSS 68K™ — has
been compiled into 68000 code. Hence, it can be used on any Macintosh™. The other
version — PGSS 030™ — has been compiled into 68020/68030 code and, as a result,
can only be used on Macintoshes with a 68020, 68030, or 68040 CPU. If your copy of
the program has had the name changed, do a “Get Info” and check the version number.
If you have PGSS 68K™, the version number will read “1.0 (68K).” If you have PGSS
030™, it will read “1.0 (030).” If you have one version and need the other, let me
know.

Since PGSS™ needs at  least  500K to operate,  a Macintosh with more than
1MB of RAM will be needed. A hard drive is recommended, although not necessary.

IMPORTANT NOTE:  PGSS™ is, as of this release, a monochrome (black-
and-white) program. I have tried to spruce it up with color icons, but no amount of
fiddling with your monitor or Control Panel will produce color. One sure way to turn
PGSS™ into a vibrant, eye-pleasing, color experience, though, would be for about ten
thousand — or, better yet, a hundred thousand — people to become registered owners
at the low, low price of ten bucks a head.

• What is the history (and future) of PGSS™?

This is probably not a question you are asking, but one for which you will get
an answer anyway. Two years and a couple of thousand man-hours ago, I got tired of
trying  to  use  spreadsheets  to  keep  track  of  golf  scores.  Being  an  inveterate  and
impenitent hacker of both Macintoshes and little white balls, I thought there had to be a
better way. And, from that tiny acorn sprung a mighty oak…

Even though what  you see now is  labeled as version 1.0,  nothing could be
further from the truth. Calling this program “1.0” is just a convenience to keep people
from asking what the first seventy-four versions were like. PGSS™, like its creator,
has just gotten better with age, and with a little help from the people who use it, it (and
he) will continue to do so.

That was the wind-up. Here’s the pitch. For the exceedingly reasonable sum of
ten  dollars  ($10.00  US),  you  can  become  a  registered  owner  of  this  program.  In
addition to the warm and fuzzy feeling you will get from the guilt-free possession and
use of PGSS™,  I will keep your name and address on file and notify you of updates,
bug fixes, and other relevancies, as they become available. 

If you decide to keep and use PGSS™, please send your ten-spot (or a check or
money order in that amount), along with your name, address, and telephone number to:

Jack Browning
210 McKnight Road

Fairview Heights, Illinois  61920

In return for your consideration and support, I will do my best to insure that
your money is well-spent.
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CREATING A PGSS™ COURSE FILE

The basic component of PGSS™ is the course file. It contains the information
about a course (the yardage and par of each of its holes) and, among other things, holds
all of a player’s scores for that course. For ambitious folks who would like to write
programs that access the information contained in their PGSS™ course files, I have
provided a Pascal record declaration for the files in the technical appendix.

PGSS™ lets you create separate course files for 9- and 18-hole courses. Each
file can hold up to 500 scorecards. For an 18-hole course file, half of a round (i.e.,
playing only the front or back nine) counts as a single scorecard. PGSS™ course files
look like this on the desktop:

9-Hole Course 18-Hole Course 
On color desktops, 9-hole icons are red with a light gray number and 18-hole

icons are light gray with a red number.

To create a PGSS™ course file, select  Eighteen… or  Nine… from the  New
hierarchical menu item in the File menu and a new course dialog will appear. The 18-
hole new course dialog looks like this:

Enter the par and yardage in the appropriate text edit boxes. When you are
finished entering the information for a hole, press the “Next” button. This will add the
hole’s data to the par and yardage columns in the left portion of the new course dialog.
To go backwards through the holes, hit the “Previous” button. To enter the data for a
hole without moving to another one,  press the “Enter” button.  When you are done
entering the course information, press the “OK” button. Pressing “Cancel” at any time
will leave the new course dialog, and any data you’ve entered will be lost.

To  edit  information  you’ve  already  entered  for  a  hole,  use  the  “Next”  or
“Previous” buttons to move to that hole, or click on the par or yardage cells for that
hole in the columns on the left side of the dialog box. Clicking on a cell will transfer
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the data for that hole to the text edit boxes and select the text in either the par or
yardage edit box.

Features of the New Course Dialog

Like every dialog in PGSS™ which has a title bar, the new course dialog can
be dragged around the desktop. It is, however, a modal dialog. This means that you
won’t be able to select menu items or click in any other windows or the desktop until
you dismiss the new course dialog. In that sense, it is not a “movable modal dialog” as
defined by Apple. If you want to give it a name, call  it  a “mutant movable modal
dialog” or “MMMD.”

Also, like every dialog in PGSS™, all the buttons in the new course dialog
have keyboard equivalents. Unlike the keyboard equivalents for menu items, you do
not have to hold down the command key to use the button equivalents — you simply
press the key you want. The button equivalents for the new course dialog are:

Button Equivalents
OK “O” or “o”

Cancel “C”, “c”, Return, or Esc
Next “N”, “n”, or “+” (plus

sign)Previous “P”, “p”, or “-” (minus
sign)Enter “E”, “e”, or Enter

In addition to using the Tab key to move between text edit fields in the new
course dialog, you can also hit the period or decimal point  (“.”) key.

Using the keyboard equivalents and your Macintosh™ keypad, entering course
data becomes very quick and easy. The keying sequence for that operation works like
this:

par Type in par
“.” Tab to yardage field

yardage Type in yardage
“+” Enter data and move to

next hole
Note For Those Who Play On Courses With Par 6 Holes

Par 6 holes are not supported by PGSS™. The only acceptable values for par
are 3, 4, and 5. In addition, the yardage for a hole must fall between 1 and 999 yards.
The management is sorry for any inconvenience this causes.

When you’ve completely entered your course information and checked it, press
the “OK” button.  If all  the values you entered were acceptable,  an empty PGSS™
window — like the one shown in the next section — will appear. It will be named
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“Untitled • 1” (or “2” or “3”, etc.).

At this point, you might want to check your course information one more time.
If it’s correct, select  Save from the File menu and use the standard Macintosh™ file
dialog box to save the course file under any name you choose. If you think you might
be using the same course information for other course files, you may want to save your
empty window as a template. You could then use the  Save As… item from the  File
menu to save copies of the template as specific course files.

Using PGSS Page 6



THE PGSS™ COURSE WINDOW

A PGSS™ course window is where the basic information about a course and its
scores is displayed. Every open course file will have its own window. You may have up
to eight course file windows open at the same time.

For an 18-hole course, an empty course file window looks like this:

The  title  bar,  of  course,  tells  you  the  name of  the  file  associated  with  the
window. It also contains the close and zoom boxes for the window. 

Clicking in the close box of a PGSS™ window works as you might expect — it
closes the window and its file.

Clicking in the zoom box, however, iconizes a PGSS™ window — converts it
into a small iconic representation of the window. To expand an iconized window, just
click in the zoom box again and the window grows to its original size. All of your data
will be in exactly the same state as you left it. 

Iconized windows can be selected and moved around the desktop by their title
bars. While they are iconized, however, only PGSS™ file operations (saving, printing,
etc.) can be performed on them. Iconized windows look like this:
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9-Hole Window 18-Hole Window

Since the titles for iconized windows disappear when the windows are shrunk,
if you need to identify or select a particular iconized window, use the window list
appearing at the end of the View menu. Iconized windows will have a hollow diamond
to the left of their name in that list.

The content region of a PGSS™ window is divided into four parts. The part
farthest to the left is the scorecard area. This is where the course information and your
scorecards are displayed. Directly above the column headings in the scorecard area, on
the same level as the titles for the distribution and averages areas, are two boxes. The
left box of this pair will display the number of the scorecard you are viewing — in the
illustration above, since it’s an empty PGSS™ window, that number is “0”. The right
box will show you the date of the scorecard currently being displayed.

Next  to  the  scorecard  area  is  the  distribution  area.  This  is  where  the
distribution  of  your  scores  is  displayed.  The column headings  for  this  area  are  as
follows:

Heading Meaning
-- Eagles and double eagles
- Birdies
E Pars
+ Bogeys

++ Double bogeys
+++ Triple bogeys
!!! Quadruple bogeys and above

As you can see from the table, scores better than eagle are put in the eagle
column,  and  scores  worse  than  quadruple  bogey  are  put  in  the  quadruple  bogey
column. If you need to view the complete distribution of scores for a certain hole, you
can, as we shall see later, obtain that information very easily. 

To the right of the distribution area is the averages area. This is where scoring
averages, low and high scores, and par differential are displayed. The column headings
for this area are self-explanatory. 

Finally, to the right of the averages area is the  button area. This is literally
where the action is in a PGSS™ window. When all of its buttons are enabled, the
button area of a window looks like this:
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The top button is the “New Card” button. As its name implies, you press it
when you want to add a new card to your course file. Directly below the “New Card”
button is the “Trash” button. You press it when you want to delete a card from your
course file.

The two arrow buttons move you through your cards. You can use the up arrow
to move forward and the down arrow to move backward. Every time you click in an
arrow a new card is shown in the “SCR” column of the scorecard area, along with its
number  and  date.  In  addition,  the  appropriate  cells  in  the  distribution  area  are
highlighted to display the scoring distribution for that card. To browse through your
cards, click and hold the mouse down on an arrow button. PGSS™ will continue to
cycle through your cards until you release the mouse button.

To move directly to the first card in your course file, hold down the option key
and click on the down arrow button. To move to the last card, hold down the option
key while  clicking on the up arrow button.

Any buttons that are grayed-out are inactive. Pressing on them will have no
effect. The “New Card” button is active when a course file has less than 500 cards. The
“Trash”  button  is  active  when there  is  at  least  one  scorecard  in  a  file.  The arrow
buttons are active when there are two or more scorecards in a file. 

The window buttons also have keyboard equivalents. They are:

Button Equivalent
New Card “N” or “n”

Trash “T” or “t”
Up Arrow “U”, “u”, “+” (plus), or up arrow

Down Arrow “D”, “d”, “-” (minus), or down
arrow

The keyboard equivalents will not work with disabled buttons. Holding down
the key equivalent for an arrow button is the same as holding down the mouse button.
Holding down the option key while typing an equivalent for an arrow button is the
same as holding down the option key while clicking on an arrow button.

Just above the button area is a small box to remind you of the order in which
your scorecards for that window are sorted. Since every open window in PGSS™ can
have its cards sorted in a different order, if you get confused, just check the box. It will
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display one the following labels:

Label Sort Order
ENTRY By entry order
DATE By date

FRONT By front nine
scoreBACK By back nine
scoreTOTAL By total score

1st, 2nd,
etc.

By Nth hole score
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ADDING A CARD TO A PGSS™ COURSE FILE

After pressing the “New Card” button (or its keyboard equivalent) in a PGSS™
window, the new card dialog box will appear. For an 18-hole course, the new card
dialog looks like this:

The new card dialog operates the same as the new course dialog with a few
minor differences. The first is that you only enter one value — the score — per hole.
By using the keypad and “+” equivalent for the “Next” button, entering scores is fast
and easy. The key sequence for that operation is:

score Type in score
“+” Enter data and move to

next hole
That’s all there is to it.  In fact, with just a little practice, the scoring for an

entire 18-hole round can be entered in less than twenty seconds.

The keen observer will notice two items in the new card dialog that were not in
the new course dialog. The first of these is a box displaying the current date. This box
is called the date box. PGSS™ assumes that the date for a new card will be the date
the card is created. If that is not the case, click on the date box and a smallish dialog
box will appear in the lower right-hand corner of the new card dialog. It looks like this:

By clicking on the plus or minus boxes to the right of the numbers, you can set
the date to whatever you want. The numbers are ordered in a M/D/Y format — the date
shown in the illustration, for example, is February 22nd, 1994. When you have set the
appropriate date, press the “OK” button — or type “O” or “o”. If you have entered a
valid date, the date dialog will disappear and the date you entered will take its place in
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the date box of the new card dialog.

PGSS™ checks the date to make sure that the month and day correspond. If the
month is February, it will adjust the number of days for leap years. It will also check to
see  if  the  date  falls  within  the  range  that  PGSS™  supports:  January  1,  1941  to
February 6, 2040. If you attempt to enter an invalid date, PGSS™ will beep and the
date dialog will not disappear. You can change the date and try again or press “Cancel”
— or type “C”, “c”, Enter, Return, or Esc — to leave the date dialog. “Cancel” will
return you to the new card dialog without making any changes to the card’s date.

Sorry,  there  are  no  keyboard  equivalents  for  the  date-setting  controls.
Management apologizes for any inconvenience this may cause.

The  second  unique  item  in  the  new  card  dialog  is  called  the  half-round
selector. It looks like this:

You use the half-round selector to tell PGSS™ that you only played the front or
back nine of an 18-hole course. By default, the new card dialog box for an 18-hole
course sets the selector (as in the illustration above) for a complete 18-hole round. To
change that, simply click in the appropriate selector box. Clicking on the first box tells
PGSS™ you only played the front nine. Clicking on the second tells it you only played
the back nine. In each instance, PGSS™ only allows you to enter scores for holes on
the nine you chose. You can change nines or go back to eighteen holes at any time, but
if you deselect a nine in which you have already entered scores, those scores will be
cleared.

When you’ve finished entering the scores for a round, press the “OK” button. If
the scores you have entered are valid, the new card dialog will disappear and your
course file’s window will be updated to reflect the new card. PGSS™ will only allow
you to enter a score between 1 and 25 for any hole. Any holes zeroed by the half-round
selector are taken care of automatically by PGSS™. Hitting “Cancel” at any time will
leave the new card dialog. No changes will be made to the course file and and any
scores you entered will be lost.

To edit a score you’ve already entered, use “Next” or “Previous” to move to
that hole, or click on the score’s cell in the columns on the left side of the dialog box.
Clicking on a cell will move the score in that cell to the text edit box and select it for
editing.

Features of the New Card Dialog

Like its cousin, the new course dialog, the new card dialog is an MMMD. It can
be moved around the desktop by its title bar, but no mouse clicks will register in the
menu bar, desktop, or other windows until it has been dismissed.

The button equivalents for the new card dialog are:

Button Equivalents
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OK “O” or “o”
Cancel “C”, “c”, Return, or

EscNext “N”, “n”, or “+”
(plus)Previous “P”, “p”, or “-”

(minus)Enter “E”, “e”, or Enter

The date box and half-round selector can also be controlled from the keyboard.
The equivalents for these items are:

Item Equivalents
Date box “D” or “d”

Half-round selector
(front 9)

“F” or “f”
Half-round selector

(back 9)
“B” or “b”

Half-round selector (18) “A” or “a”

After you press the “OK” button and PGSS™ validates your scores, it goes to
work  updating  your  course  file  to  reflect  the  new  information.  It  adds  the  new
scorecard  to  your  score  distribution,  recalculates  your  scoring  averages  and  par
differentials, and alters your low and high scores as needed. If your cards are sorted in
some order other than the order in which they were entered, PGSS™ also re-sorts your
course file. On my hoary old Mac Plus, this process (and others) took a small  but
noticeable amount of time. To give the user some visual feedback, I made the cursor
change to reflect the operations that were taking place. In all probability you will never
see these cursors, but, in case you do, here’s what they look like and mean:

     PGSS™ is calculating…

    PGSS™ is sorting…

PGSS™ is throwing a card away…

PGSS™ is compiling a distribution…

PGSS™ is finding something…

PGSS™ is printing…

In any event, after PGSS™ finishes its behind-the-scenes update of your course
file, it will display the results visually in your course file’s window. An 18-hole course
file window looks like this after a couple of scorecards have been entered:
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Notice  how the  cells  in  the  distribution  area  are  highlighted  to  reflect  the
distribution of the scorecard currently being displayed.

You should also note that PGSS™ — after leaving the new card dialog — will
always show you the scorecard you just entered. This may be a trifle confusing if you
have entered a card which, because of its date or one of its scores, gets sorted into the
middle of a course file. Just remember that the number shown next to a scorecard’s
date in the course file only represents the relative position of that card in the course
file,  as  the  file  is  currently  sorted.  That  number  can,  and  probably  will,  change
whenever you sort your course file by a different item. 

After your course file’s window has been updated, it’s usually a pretty good
time to go back and check the scores you entered again. If they’re up to snuff, select
the Save item from the File menu and save the changes you’ve made to your course
file.

If, on the other hand, you made a mistake entering your scores for a round, hit
the Trash button and throw away the error-stricken card. You can then enter the correct
scores on a new card.

All of which brings us around to one of PGSS™’s dirty little secrets: by design,
it does not support hole-by-hole editing of existing scorecards. Some of the earlier
versions of PGSS™ did have this capability. What I discovered, however, was that
hole-by-hole editing made it just too easy to revise one’s golfing history (“Did I really
take a six on that hole? I’m almost positive it was only a five.”), either consciously or
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unconsciously.  So,  in  order to preserve the integrity of the game (and your course
files), I made it a tad bit harder to go back and change a score that’s already been
entered.  It  shouldn’t  be  any  great  burden,  really,  since  PGSS™  gives  you  ample
opportunity to check your scorecards before you enter and save them.
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DELETING A CARD FROM A PGSS™ COURSE FILE

Deleting a card from a course file is simple, quick, and easy. PGSS™ does all
the heavy lifting.

To delete a card, navigate through your course file using the arrow buttons until
the card you want to delete is displayed. Once it is, press the Trash button in your
course file’s window. PGSS™ will then present an alert box that looks something like
this:

If you want the card deleted, press the “Yes” button in the alert box — or type
“Y” or “y” — and PGSS™ will  delete the card from the course file,  updating the
course file (and its window) to reflect the deletion. Again, you might see the cursor
change while the behind-the-scenes machinations are going on.

If you don’t want the card deleted, just click on “No” — or type “N”, “n”,
Return, or Enter. The alert box will disappear and no changes will be made to the file.
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HOW PGSS™ MAINTAINS A COURSE FILE
(AN ITEM OF REVERSIONARY INTEREST)

When a course file is opened by PGSS™, all the information contained in that
file is loaded into your computer’s memory. Any changes you make to a file (adding
cards, deleting cards, changing the sort order, etc.) are not saved to disk until you tell
PGSS™ to save the file.  In  other  words,  PGSS™ does  not automatically  save the
changes to a course file.

PGSS™ will, however, ask if you want to save a changed course file before it
closes the window for that file. It will also ask you if you want to save any changed
course files before it quits.

If you have changed a course file but have not yet saved that file to disk, you
can go back to the last saved version of the file by selecting Revert… from the File
menu. If you select the  Revert… item, PGSS™ will display an alert box that looks
like this:

Pressing the “Yes” button for this alert — or typing “Y” or “y” — will the load
the contents of the last saved version of the course file into your computer’s memory.
That will replace the course file already in memory. Any changes you made to the file
being replaced will be lost.

If you don’t want to replace the course file currently in memory, click on the
“No” button when this alert appears — or type “N”, “n”, Return, or Enter.

Another implication of the way in which PGSS™ maintains course files is that
if you should lose power to your computer or suffer an unrecoverable error while using
the program, any changes you made to files which have not been saved will be lost
when you return to the program. The moral to that story is, however, a familiar one:
save early, and save often.
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ORGANIZING CARDS IN A PGSS™ COURSE FILE

PGSS™ lets you to organize your course file by entry order, by date, by front
nine score, by back nine score, by total score, or by your scores on a certain hole. You
can change the organization of your course file by choosing the order you desire from
the Sort menu. The complete Sort menu for PGSS™ looks like this:

The order in which your course file is currently sorted will be shown in the
Sort menu by a check mark to the left of the appropriate item. In the illustration, the
course file is currently sorted by date.

If  you select  the  Hole… item from the  By Score menu,  a  dialog box will
appear asking you to enter the hole by which you want the course file sorted. The
dialog box looks likes this:

You can select the hole by which you want to sort by clicking in the plus or
minus boxes to the right of the hole number. When you have selected the hole, click on
the “OK” button or type “O”, “o”, Enter, or Return. To go back to your course file
window without sorting, hit the “Cancel” button or type “C”, “c”, or Esc.

The Sort menu will only be active when there is something for PGSS™ to sort,
i.e., when you have more than one card in a course file. PGSS™ will sort your course
file in ascending order — which means the earliest dates or the lowest scores will be at
the beginning of the file. If you are sorting your cards by date and PGSS™ encounters
two or more cards with the same date, it will sort those cards by entry order. If you are
sorting your cards by score and PGSS™ encounters two or more cards with the same
score, it will sort those cards by date. If two or more cards have the same score and the
same date, PGSS™ will sort those cards by the order in which they were entered.

The sort routines for PGSS™ are written in 68000 assembly language and, as a
result, are very fast. So fast, in fact, that you should not hesitate to use them to help
you in finding a particular card you’re looking for. For example, if you’ve played fifty
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rounds at a particular course and birdied a certain hole just once, you could sort your
course file by that hole, option-click on the up arrow to move to the first card in the
file, and immediately find the card containing the birdie.

In addition to the command-key shortcuts for items in the Sort menu, PGSS™
allows you to sort a file by front nine score, back nine score, total score, or your score
on a  particular  hole  without  using  the  Sort menu.  To do this,  just  hold  down the
command key and click on one of the boxes in the “#” column in the scorecard area of
your course file’s window. For example, if you wanted to sort your course file by your
scores on the twelfth hole, you would hold down the command key and click on the
box labeled “12”. Similarly, if you wanted to sort your file by your scores on the front
nine, you would hold down the command key and click on the box labeled “F”.

PGSS™ keeps track of which card you were looking at when you sorted your
course file. When it finishes sorting your file, you will still be viewing the same card.
The  card’s number may have changed, but, as explained earlier, a card’s number just
tells you what its relative position is in the file, as the file is currently sorted.

Normally, I keep my course files sorted by date. That way, when I add a new
card, it’s placed at the end of my file. To find out quickly how the scores on the new
card match up to my other scores, I sort the file by front, back, and then total score.
Since PGSS™ continues to display the new card I just entered, all I do is look at the
changing number of the new card to get a good idea of how the its scores compare with
the scores of my other cards.
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FINDING CARDS IN A PGSS™ COURSE FILE

Getting Home

When you save a course file, PGSS™ saves both the sort order of the file and
the card which was being displayed. That way, when you reopen a saved file, you will
see exactly what you saw when you last saved the file. When it opens a file, PGSS™
keeps track of the file’s home position. This is just the file’s sort order and the card it
displayed at the time it was opened. As long as you have not added or removed cards
from a file, you can return to a file’s home position at any time by choosing the Home
item under the Find menu. To change a file’s home position (or set a new one), simply
sort the file the way you want it, navigate to the card you want displayed, and save the
file. That sort order and card will become the file’s new home position.

Since PGSS™ considers a change in sort order or the card being displayed to
be a change in a course file, it will ask if you want to save those changes when you
attempt to close a file’s window or quit the program.

The Index

An index of the cards in a course file is available for any file which has been
sorted by date or score. This index can be obtained by choosing the Index item under
the  View menu. When that item is  selected,  a dialog box looking like this  will  be
displayed:

The dialog box illustrated represents the index for a file which has been sorted
by date. If you request an index for a file sorted by score, you will see scores listed
instead of dates.

The index dialog is an MMMD. It can be moved around by its title bar to give
you a clear view of your course file window. To dismiss the index dialog, you can
either click in its close box or type Escape, Return or Enter.

To have your course file window display a card shown in the index, just click in
the date (or score) column on the card you want to see. You can also use the keyboard
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to select an index item. Simply type the number between 0 and 9 which corresponds to
the card you want  to see.  This works identically  to clicking on that item with the
mouse. After you click on a list item (or type in its number) you will see your course
file window display the card you selected.

The “#” column to the right of the date (or score) column tells you how many
cards are in the course file under that index heading. PGSS™ will always take you to
the first card in a group if more than one card exists for a particular index heading.

If your index has more than ten headings (like the one shown above), the scroll
bar for the index dialog will be active. It operates the same as any Macintosh™ scroll
bar, with the exception that you will be paged through your index list ten items at a
time. Scrolling to individual items is not supported by the index dialog. Clicking in the
up or down arrows of the scroll bar, therefore, is just like clicking in its page-up or
page-down regions, i.e., you will move through the list ten items at a time.

While the index dialog is active, you can use the up arrow and down arrow
keys on your keyboard to control the scroll bar.

When you’ve chosen the card or group of cards you want, dismiss the index
dialog and you will have full access to the menu bar and the buttons in your course
file’s window.

Tell Me More…

In addition to finding cards with the index, you can also find cards in a course
file that meet specific criteria. By choosing the appropriate item under the Find menu,
you can find and display:

— The cards which contain your high or low scores for the front nine, back
nine, or entire course.

— The cards for the rounds in which you scored the most eagles, birdies, pars,
bogeys, double bogeys, triple bogeys, or others.

— The cards for the rounds in which you scored the most consecutive eagles,
birdies, pars, bogeys, double bogeys, triple bogeys, or others.

— The cards for the rounds in which you had the most holes over eagle, birdie,
par, bogey, double bogey, or triple bogey.

— The cards for the rounds in which you had the most consecutive holes over
eagle, birdie, par, bogey, double bogey, or triple bogey.

— The cards for the rounds in which you had the most holes under birdie, par,
bogey, double bogey, triple bogey, or other.

— The cards for the rounds in which you had the most consecutive holes under
birdie, par, bogey, double bogey, triple bogey, or other.
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— The cards which meet a certain pattern of scoring you select.

The Find Menu

This is the Find menu:

As you can see, the items in this menu correspond to the descriptions given
above.  Four  of  the  six  items  in the menu are  hierarchical.  This  means that  if  you
choose one those items, another menu will appear for you to select from. With that in
mind, let’s examine the items in the View menu.

Finding High and Low Scores

The  High and  Low menu items allow you to find your high and low scores.
When you choose one of these items, another menu will appear to the right of the
selected item. It looks like this:

By choosing the item you want from this combination of menus, you can find
your high or low scores from the front nine, back nine, or entire course. To find your
low score on the front nine of a given course, you would choose the Low-Front menu
combination. Likewise, to find your high score for eighteen holes you would select
High and  Total. If you’re working with a 9-hole course, or an 18-hole course that
doesn’t yet have any scores for the front or back nines, any irrelevant items will be
disabled in the hierarchical menu.

When  you  are  using  any  of  the  hierarchical  menus  in  PGSS™,  it  may  be
helpful to think of yourself as constructing a sentence out of menu items. The titles I
used for items have been chosen in such a way that if you follow the chain of items
across the screen, you will know exactly what you are doing.

Finding Streaks and Strings and Such
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The same concept applies to the Most and Most In Row menu items. They are
slightly  more  complicated,  however,  because  the  hierarchical  menu  which  appears
when you choose them, in turn, contains other hierarchical menu items. When you
select Most or Most In Row, the following menu appears to the right of the selected
item:

Again,  you would  use  a  combination  of  menu  items  to  find  the  cards  you
wanted. For example, if you wanted to see the card where you scored the most birdies,
you would use the  Most-Birdies combination. Likewise, if you wanted to view the
card where you scored the most pars in a row, you would select  Most In Row and
Pars. It’s really quite easy.

The  two  hierarchical  items  in  this  menu  let  you  find  the  most  or  most
consecutive scores  over  or  under  a  particular  score.  When you select  the  Over or
Under item, one of the menus below will appear to its right:

Over Menu Under Menu

Continuing with the sentence analogy, if you want to find a card which contains
the most holes under  par,  you would use the  Most-Under-Par menu combination.
Likewise, if you wanted to look at the card which contained the most consecutive holes
over  par,  you  would  select  Most  In  Row-Over-Par.  Since  a  picture  is  worth  a
thousand words, this is what the  Most In Row-Over-Par menu combination would
look like on your desktop:
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As daunting as this may seem, using the hierarchical menus becomes second
nature with just a little practice. Even though this really is the easiest way to do this
operation, I’m sure my use of multiple hierarchical menus will earn me a spot on the
Ten Most Wanted list of Apple’s interface police.

Finding a Pattern

The final item in the Find menu is the Pattern… item. As its name implies, it
lets you find cards in which a particular pattern of scoring exists. When you select this
item, the pattern dialog box appears. For an 18-hole course, it looks like this:

As you can see, the pattern dialog contains a distribution grid. You select the
items in the pattern you want to find by clicking on individual cells in this grid. You
can turn off any cell selection you have made by clicking on the selected cell. When
you have finished entering the pattern, press the “OK” button — or type “O” or “o” —
and PGSS™ will set off in search of that pattern. To cancel the pattern dialog without
finding anything, just hit the “Cancel” button or type “C”, “c”, Return, Enter, or Esc.
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PGSS™ will find only those cards which exactly match the pattern you select.
It ignores the scores of holes in which no cells are selected. For example, if you wanted
to find all of the cards in a course file in which you played 16, 17, and 18 with scores
of par or better, your pattern dialog would like this: 

You  can  select  as  many  cells  for  as  many  holes  as  you  want.  Of  course,
selecting every cell in the grid would just find every card in your course file.

To  simplify  the  process  of  entering  a  pattern,  a  couple  of  shortcuts  are
available. To select all of the valid cells for a certain hole, just click on the number for
that hole. To select all the holes that contain a certain score, just click on that score’s
column heading. You can then narrow your search by turning off some of the cells
PGSS™ has highlighted.

Tell Me Even More…

If PGSS™ can’t find any cards which meet the criteria you specified, it will tell
you so by beeping and displaying the following alert:

This alert is another of the monstrous creations from my lab. It is called an
instant alert. You will notice that it has no buttons or close box. That’s because all you
need to do to dismiss an instant alert is click the mouse or press any key. It will remain
displayed until you take one of those actions. Even though it really is a waste of time
and effort to click on a specific button or hit a specific key to dismiss an alert, this
stunt, I’m sure, will move me up to the third or fourth spot on the Ten Most Wanted
list.

If PGSS™ finds just one card that meets your criteria, it will display that card
in your course file window.

If PGSS™ finds more than one card, it will display the find dialog box, which
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looks like this:

The find dialog contains a list of all the cards which meet the criteria specified.
The illustration shows the first page of a list of cards in which the most holes under
bogey were scored. This particular list is taken from a file of my scores on the TPC of
Avenel course in PGA Tour Golf. The label and numbers to the left of the card list say
that  I  have  scored  18  holes  under  bogey,  (i.e.,  shot  a  bogey-free  round)  on  34
occasions. The card list displays the dates of the cards in which I shot those rounds.
The label and numbers will, of course, change according to the criteria you specify. If
you have found cards using a pattern, then no label will be displayed and the word
‘PAT’ (instead of a number) will appear in the “=” box of the find dialog.

The fact that this dialog looks a lot like the index dialog is no accident. They
both work in exactly the same way. The find dialog is an MMMD, meaning you can
move it to wherever you want on the desktop. To have one of the cards in the list
displayed in your course file window, simply click on the date of the card (or type the
number to the left of the card’s date).

If the list of found cards contains more than ten items (as does the list above),
the scroll bar for the find dialog will be active. It works in exactly the same way as the
scroll bar for the index dialog, i.e., it scrolls through the list ten items at a time. You
can also use the up and down arrow keys on your keyboard to control the scroll bar in
the find dialog.

When you are finished working with the find dialog,  you can dismiss it  by
clicking in its close box or by typing Return, Enter, or Esc. You will then have access
to the menu bar and the buttons in your course file’s window.
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VIEWING DATA ABOUT A PGSS™ COURSE FILE

The last menu left to explore in PGSS™ is the View menu. When it is selected
from the menu bar, it will look something like this:

Viewing a Round Summary

Since  the  Index item  has  already  been  discussed,  we  will  start  with  the
Summary item. This item is hierarchical, i.e., selecting it will display another menu
for you to choose from. When you select Summary, the following menu will appear
directly to its right:

By selecting an item from this menu, you will be able to view either a summary
of the card (round) currently being displayed in the course file window or a summary
of your scoring based on all the cards in your course file.

Choosing the Round… item will cause a round summary dialog to appear. For
an 18-hole card, the round summary dialog looks like this:

The round summary dialog displays  information about  the card showing in
your course file window, summarizing that round in terms of how you scored on par
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3s, par 4s, and par 5s, the front and back nines, and the entire course. In the example
above, a birdie, two pars, and a double bogey were scored on the par 3s, and those
holes were played one over par (+1). On the par 5 holes, an eagle and three birdies
were scored, with those holes being played a total of five under par (-5).

The round summary dialog has no buttons or close box, but it does have a title
bar. That makes it an instant MMMD. This means the round summary dialog can be
moved by its title bar anywhere on the desktop. To dismiss it,  just  click anywhere
outside its title bar or press any key. It will remain visible until your perform one of
those actions.

Viewing a Course Summary

Choosing the  Course… item will cause a course summary dialog to appear.
The course summary dialog looks like this:

As  its  name  implies,  the  course  summary  dialog  summarizes  your  scoring
based on all the cards in your course file. It does this by count and by percentage. The
count portion of the course summary dialog displays the distribution of your scores on
the par 3s, par 4s, and par 5s of a course. It  also calculates and displays your par
differential for those holes.

The  percentage  part  of  the  course  summary  dialog  shows  your  scoring
percentages for par 3s, par 4s, par 5s, and the entire course. In the illustration, eagles
are scored 5.0% of the time on par 5 holes and 1.5% of the time for the course overall.
Pars are scored 57% of the time on par 3 holes and 51.6% of the time for the course
overall. The percentages for a category may add up to slightly more or less than 100%
due to rounding error.

The  course  summary  dialog,  like  the  round  summary  dialog,  is  an  instant
MMMD — it  can be moved around the desktop by its  title  bar  and dismissed by
clicking anywhere outside the title bar or pressing any key.
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Viewing a Distribution of Scores

The next item under the View menu is entitled Distribution. It is a hierarchical
item, which means it will present another menu when it is selected. When you choose
the Distribution item, the following menu will appear to its right:

By selecting an item from this menu, you can obtain a distribution of your
scores for a particular hole, for the front or back nines, or for the entire course.

Choosing  Hole… from this  menu will  bring up a dialog box asking you to
select the hole for which you want the distribution. The hole selection dialog looks like
this:

You can choose the hole by clicking in the plus or  minus boxes to the right of
its number. When the hole you want is displayed, click the “OK” button — or press
“O”, “o”, Return, or Enter. If you change your mind about viewing a distribution of
your scores, just hit the “Cancel” button — or press “C”, “c”, or Esc.

Selecting Front, Back, or Total from the Distribution menu will give you the
appropriate distribution of scores immediately. After you have chosen the distribution
you want, PGSS™ will show it to you in a distribution dialog box, which looks like
this:

As you can see, there are four columns of information in a distribution dialog.
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The first column — which will have “F”, “B”, “T”, or a hole number as its heading,
depending on the kind of distribution you chose — shows the scores that make up the
distribution.

The next three columns display the following information:

Column Information Displayed
“#” The number of times a score has been shot

“Cum” The number of times that score or lower has 
been shot“Date” The date on which that score was last shot

In the illustration above, for example, a score of 66 was shot 18 times, a score
of 66 or lower was shot 62 times, and that score was last shot on February 22nd, 1994.

The distribution dialog is an MMMD — it can be moved around the desktop by
its title bar, but no mouse clicks will register in the menu bar, windows, or desktop.
You can dismiss the distribution dialog by clicking in its close box or typing Return,
Enter, or Esc.

If the distribution contains more than ten items (as does the one above), the
scroll bar for the distribution dialog will be active. It works in exactly the same way as
the scroll bar for the index and find dialogs, i.e., it scrolls through the distribution ten
items at a time. You can use the up and down arrow keys on your keyboard to control
the scroll bar.

You  should  note  that  when you ask  for  a  distribution  of  your  scores  on  a
particular hole, PGSS™ will, unlike the distribution area of your course file window,
display the distribution of all of your scores for that hole. In other words, any double
eagles or scores over quadruple bogey will be separately compiled and displayed.

PGSS™ allows you to obtain a distribution of your scores without selecting an
item from the Distribution menu. To do this, just hold down the option key and click
on one of the boxes in the “#” column of the PGSS area of your course file window.
For example,  if  you wanted a distribution of your scores for the twelfth  hole,  you
would hold down the option key and click on the box labeled “12”. Similarly, if you
wanted to look at the distribution of your scores for the front nine, you would hold
down the option key and press on the box labeled “F”.

Viewing Hole Rankings

The next item in the  View menu is entitled  Rankings.  Being a hierarchical
menu item,  it  will  present  another  menu when it  is  selected.  When you select  the
Rankings item, the following menu will appear to its right:
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Selecting the first item in the  Rankings menu,  +/-, will display a list of the
holes for the course, sorted by the amount over or under par you played them. This list
is ordered from easiest to hardest. In other words, the holes on which you shot best in
comparison to par will be put at the top of the list and your worst holes will be put at
the bottom.

For an 18-hole course, the differential dialog looks like this:

The column of numbers displayed along the left side of the differential dialog
show the rankings of the holes. In the example above, taken from a file of my scores
on the PGA West course in PGA Tour Golf, you will notice that two holes, the 3rd and
the 15th, have tied for twelfth in the ranking.

The differential dialog is an instant MMMD. This means that it can be moved
by its title bar and dismissed by clicking anywhere outside the title bar or pressing any
key.

The next item in the  Rankings menu is  Percentage. It’s a hierarchical menu
item and selecting it will cause the following the menu to appear to its right:

By selecting an item from this menu, you will be able to obtain a sorted ranking
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of the  holes  of  a  course  in  terms of  the percentage of  times you have  obtained a
particular kind of score (or better) on them.

For an 18-hole course, the percentage ranking dialog looks like this:

This particular percentage ranking dialog, taken again from my course file for
PGA West,  shows a ranking based on par  percentage — note the “E” label in the
middle column of both the count and percentage tables. The numbers along the left
side of the dialog show the rankings of the holes, from highest percentage to lowest
percentage.

To the right of the yardage and par information about the holes is the count
table. It shows, for each hole, the number of times you have scored under (<), at, or
above (>) the score in question. For example, on the first-ranked hole — the par-5 16th
— I've had 133 scores under par, 75 pars, and four scores over par.

To the right of the count table is the percentage table. It shows, for each hole,
the percentage of times you have scored under (<), at,  or over (>) a certain score.
Continuing with the example given above, on the first-ranked hole I’ve scored under
par 62.7% of the time, at par 35.4% of the time, and over par 1.9% of the time.

The holes in this dialog are ranked according to the percentage of the time you
shot at  or under a particular score. In the illustration, for example, they are ordered
according to the percentage of times par or better was shot on a hole. You can figure
the  score-or-better  percentage  for  a  hole  by  adding  the  numbers  in  the  first  two
columns of the percentage table or, perhaps even easier, subtracting your over-score
percentage from 100. You should note that, due to rounding error, the percentages for a
hole might not add up to exactly 100%.
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If two or more holes have the same score-or-better percentage, they are ranked
in  order  of  their  under-score  percentages  — the  hole  with the  highest  under-score
percentage will receive top billing. For example, the third- and fourth-ranked holes in
the illustration — the 8th and the 12th — both have a  par-or-better  percentage of
93.9%.  The  8th  hole  is  ranked  ahead  of  the  12th,  however,  because  its  under-par
percentage is larger. Holes will have a tie ranking only when their under-, at-, and over-
score percentages are identical.

The percentage ranking dialog is an instant MMMD, meaning it can be moved
by its title bar and dismissed by clicking anywhere outside the title bar or pressing any
key. Until  one of these actions  is  taken, the percentage ranking dialog will  remain
visible.

Viewing a Summary of Previous Scores

The next item in the View menu, Last…, allows you to view a summary of up
to fifty of your previous rounds. This item will be active only when your course file
contains three or more cards and is sorted by date. When you select the Last… item,
the following dialog box will appear:

You can select the number of cards you want to summarize by clicking on the
plus or minus boxes to the right of the number. When you have selected the number
you want, click on the “OK” button or type “O”, “o”, Return or Enter. If you decide
not to view the summary, just press the “Cancel” button, or type “C”, “c”, or Esc.

The minimum number of rounds you can summarize is two. The maximum
number of rounds you can summarize is one less than the number of cards in your
course file, up to an absolute limit of fifty. In other words, if your course file contains
thirty-five cards, you could summarize the last thirty-four. If, on the other hand, your
course file has sixty cards, you could only summarize the last fifty.

When it compiles this summary, PGSS™ treats any half-rounds you played as a
whole round. For example, if you ask for a summary of your last ten rounds on an 18-
hole course and one of those rounds is a card for the front nine only, the summary will
be based on ten front-nines and nine back-nines.  

After  you’ve  selected  the  number  of  rounds  you  want  to  summarize,  the
summary dialog will appear. For an 18-hole course, it looks like this:
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The name of the summarized course and the number of rounds summarized will
be shown in the title bar. Apart from that, the summary dialog looks a lot like your
course file window. It contains exactly the same information, except that individual
scorecards are not displayed and there are no buttons. The summary dialog is read and
interpreted just like a course file window.

The summary dialog is an instant MMMD, which means it can dragged around
the desktop by its title bar. It will remain visible until you click anywhere outside the
title bar or press any key.

The Window List

When any course file windows are open, the View menu will contain a list of
those windows. The window list, if one exists, will be placed after the Last… item. 

To activate a window and bring it to the front, select its name from the window
list. 

To activate a window, bring it to the front,  and center it on the desktop, hold
down the command key while selecting its name from the window list. 

Any iconized windows will appear in the window list with a hollow diamond to
the left of their names. In the sample View menu, for example, the window for PGA
West has been iconized.
PRINTING A PGSS™ COURSE FILE
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PGSS™ can print the cards in a course file, along with the data contained in the
distribution and averages areas of your course file window. The printing capabilities of
the program are not as sophisticated as I would like, primarily because I hate working
with the Print Mangler, er, I mean Manager. PGSS™ will, however, generate hard copy
which is acceptable for all but the most genteel uses. If this program produces any
response  at  all,  I  swear  I’ll  go  to  Developer  University  and  learn  how  to  write
magnificent printing code…

PGSS™ was designed to print on 8-1/2 by 11 paper, single-sheet or fanfold. It
will print in both portrait and landscape modes. It prints in 9-point Monaco on a dot
matrix  printer  (ImageWriter).  For  laser  printers,  print  your  document  with  font
substitution turned on to get 9-point Courier.

To print information from a PGSS™ course file, select Print… from the File
menu. A dialog will appear, asking you to select the kind of document you want to
print.

The name of the course file is shown at the top of the print selection dialog.
Until you select a document to print, the “OK” button will remain inactive.

As you can see, PGSS™ allows you to print three different types of documents:
a listing of your scores, your scoring distribution, or your scoring averages. The latter
two  documents  will  contain  exactly  the  same  information  as  is  displayed  in  the
distribution and averages areas of your course file window.

PGSS™ will not, however, allow you to print all three kinds of documents in
the  same print  request.  You  can  print  either  your  scores,  or  your  distribution  and
averages  in  a  single  print  request.  If  you click  on  the  “Scores…” check  box,  the
“Distribution” and “Averages” check boxes will be cleared and made inactive. If you
select the “Distribution” or “Averages” check boxes, the “Scores…” check box will be
cleared and made inactive. If you want to print your scores, distribution, and averages,
therefore, you must do it in two separate print requests.

If you decide you do not want to print from your course file, just press the
“Cancel”  button.  You  will  return  to  your  course  file  window and nothing  will  be
printed.
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There are  keyboard equivalents  for every item in the print  selection dialog.
Using a keyboard equivalent is the same as pressing the mouse button on an item. The
equivalents are:

Item Equivalents
Scores… “S” or “s”

Distributio
n

“D” or “d”
Averages “A” or “a”

OK “O” or “o”
Cancel “C”, “c”, Return, Enter, or

Esc

Printing Scores

You can print the scores in a course file by clicking on the “Scores…” check
box in the print selection dialog. PGSS™ prints scores in the order in which they are
sorted in your course file. If you have more than one card in your course file, PGSS™
will allow you to print a selected range of the cards.

If you are printing scores for a course file with more than one card, this dialog
will appear after you have finished with the print selection dialog.

This is the range selection dialog. It allows you to choose a range of cards to
print. As with the print selection dialog, the name of the course file you are printing
appears at the top. The range selection dialog also tells you how many cards are in that
file.

The range selection dialog assumes you want to print all the cards in a course
file.  The “All” radio button will, therefore, be on when the dialog first appears. If you
want to select a range of cards to print, just click on the “From” radio button, and the
edit boxes to the right of that button will become active. You can then enter a range of
cards you want to print. The numbers you enter in the edit boxes will correspond to the
numbers of the cards in your course file window. If you are unsure of the range you
want to print, just click on the “Cancel” button, return to the course file window, and
use the arrow buttons or index to find the numbers of the cards for your range.
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You can enter any three-digit number you want in the edit boxes. PGSS™ will,
however, only accept values that fall between one and the number of cards in your
course file. When you click on the “OK” button in the range selection dialog, PGSS™
checks the values you have entered. If either of them is out of range, PGSS™ will beep
once and highlight the edit box of the offending value.

If you have entered acceptable values in the range selection dialog, pressing
“OK” will take you to the standard Macintosh™ print dialog. You can leave the range
dialog at any time by pressing the “Cancel” button. You will return to your course file
window and no scores will be printed.

All of the items in the range selection dialog have keyboard equivalents. Using
an equivalent is the same as clicking the mouse on an item. The equivalents are:

Item Equivalents
All “A” or “a”

From “F” or “f”
OK “O” or “o”

Cancel “C”, “c”, Return, Enter, or
Esc

Printing Distributions and Averages

The distribution and averages for a course file can be printed by clicking on
their check boxes in the print selection dialog. You can print either or both of these
items in the same print request. If you choose to print both of them, they will be put on
the same page, if possible.

After you have selected one or both of these items, just  click on the “OK”
button in  the print  selection dialog and the standard Macintosh™ print  dialog will
appear.
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TECHNICAL APPENDIX

Making PGSS™ as fast as possible was a paramount design consideration. The
results, I believe, speak for themselves. 

To obtain that speed, though, required some tradeoffs. Since PGSS™ windows
contain so much information — an 18-hole course file window, for example, displays
297  different items of data — I decided early on to do all of PGSS™’s drawing in
offscreen  buffers  and  blast  the  bits  from  those  buffers  into  windows  that  needed
updating.  The  effect  of  that  is  to  make  a  PGSS™ window update  seem virtually
instantaneous.

The tradeoff comes in terms of memory usage. Each open PGSS™ window has
an offscreen buffer. For an 18-hole window, that buffer uses 19,008 bytes of memory.
In addition, each PGSS™ course file is loaded entirely into memory when it’s opened.
An 18-hole course file with a maximum of 500 cards in it, therefore, consumes another
25,572 bytes. That adds up to 44,580 bytes of memory — and doesn’t even take into
account what the system uses to maintain a window. Speed, as you can see, does not
come cheaply.

Another  area in  which I  splurged on memory usage was the dialogs which
display round and course information.  Since some of these dialogs show nearly as
many items as a course file window, updating them by drawing each individual item
would be noticeably, if not painfully, slow. To ameliorate this problem, PGSS™ only
draws the information in these dialogs once,  when the dialog first  appears.  It  then
converts the contents of the dialog window into a QuickDraw picture, and uses that
picture for any subsequent updates. All of this behind-the-scenes stuff is transparent to
the user.

The final area in which I put my programmer’s snout deep into the memory
trough was with the various and sundry lists PGSS™ displays — a course file’s index
and the list of found items. Each of these lists is a linked list of individual items created
on the fly. Since all of these lists can, theoretically, contain up to five hundred items,
PGSS™ puts the Memory Manager through quite a workout. It is a credit to the folks
at Apple that things work as quickly and as smoothly as they do.

The memory requirements for PGSS™ may, therefore, seem extravagant. The
simple fact of the matter is, however, that memory is cheap. And, really, compared to
some of the blue-ribbon, best-of-fair memory hogs on the market, PGSS™ is little
more than a piglet.

If you should encounter a low-memory situation in PGSS™, I have done my
best to let you exit from it safely and gracefully. When it starts up, PGSS™ allocates a
32K block of reserved memory called a  monitor. The monitor will be tapped only
when PGSS™ has no other memory to use. If PGSS™ uses the monitor in the course
of performing an operation, it will post an alert which informs you of that, tells you
how dire  the  memory situation  is,  and suggests  your  next  course of  action.  To be
honest  with  you,  I  have  never  seen  a  memory  alert  while  using  PGSS™  in  its
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recommended partition size, even working with eight, 500-card, 18-hole course file
windows open at the same time. If you change the partition size, however, you might
see  one.  If  you  cannot  recover  from  a  low-memory  situation  in  the  way  I  have
described, please let me know.

PGSS™ also preflights every call it makes to the Resource Manager. In other
words, it checks to make sure a resource is available before it uses it. If PGSS™ tries
to  perform  an  operation  which  requires  a  missing  resource,  it  will  beep  and  not
perform the operation.  You should note that  nothing in  PGSS™’s resource  fork is
meant to be user-serviceable. Any changes you make to PGSS™’s resources are done
at your own risk.

PGSS™ also checks the error codes from every File Manager call it makes. If it
encounters an error in the course of performing a file operation, it will attempt to return
the file it was working with to the state it was in before the operation began. It will
then post an alert telling you the type of error which occurred. PGSS™ will explain the
file error in reasonably plain English.

For you adventurous programmer types, here, as promised, are the file formats
for PGSS™’s course files. Bon appetìt! — and, hey, be careful out there…

CONST

kHole1 = 1;
kHole9 = 9;
kHole18 = 18;

kEagle1 = -2;
kBogey4 = 4

TYPE

HoleRecord = RECORD  { Hole description }
   par: INTEGER;
   ydg: INTEGER;

END;

Holes09 = ARRAY[kHole1..kHole9] OF HoleRecord;  { 9-hole hole array }
Holes18 = ARRAY[kHole1..kHole18] OF HoleRecord; { 18-hole hole array }

RatingRecord = RECORD { Present but not used in PGSS™ 1.0 }
   usga: REAL; { USGA course rating }
   slope: REAL; { Course’s slope rating }

END;

Crs09Ptr = ^Course09; { Pointer to a 9-hole course }
Crs09Hdl = ^Crs09Ptr; { Handle to a 9-hole course }

Course09 = RECORD { This is a 9-hole course }
   next: LONGINT; { Unique ID number of next card in file }
   hole: Holes09; { Holes of the course }
   cA: HoleRecord; { Total yardage and total par }
   rtng: RatingRecord; { Not used }

END;
Using PGSS Page 39



Crs18Ptr = ^Course18; { Pointer to an 18-hole course }
Crs18Hdl = ^Crs18Ptr; { Handle to an 18-hole course }

Course18 = RECORD
   next: LONGINT; { Unique ID number of next card in file }
   hole: Holes18; { Holes of the course }
   cF: HoleRecord; { Total yardage and total par — front }
   cB: HoleRecord; { Total yardage and total par — back }
   cA: HoleRecord; { Total yardage and total par — course }
   rtng: RatingRecord; { Not used }

END;
Score09 = ARRAY[kHole1..kHole9] OF INTEGER; { 9-hole score array }
Score18 = ARRAY[kHole1..kHole18] OF INTEGER; { 18-hole score array }

Card09Ptr = ^Card09; { Pointer to 9-hole card }
Card09Hdl = ^Card09Ptr; { Handle to 9-hole card }

Card09 = RECORD { A 9-hole scorecard }
   ID: LONGINT; { Unique ID number of card }
   date: LONGINT; { Date of card, i.e., seconds since 1/1/1904 }
   score: Score09; { Scores }
   sA: INTEGER; { Total score }

END;

Card18Ptr = ^Card18; { Pointer to 18-hole scorecard }
Card18Hdl = ^Card18Ptr; { Handle to 18-hole scorecard }

Card18 = RECORD { An 18-hole scorecard }
   ID: LONGINT; { Unique ID number of card }
   date: LONGINT; { Date of card, i.e., seconds since 1/1/1904 }
   score: Score18; { Scores }
   sF: INTEGER; { Score on front }
   sB: INTEGER; { Score on back }
   sA: INTEGER; { Score on course — equals 0 if card is half-
round }

END;

FileHeaderPtr = ^FileHeader; { Pointer to file header }
FileHeaderHdl = ^FileHeaderPtr; { Handle to file header }

FileHeader = RECORD { Access to common data of 9- and 18-hole files } 
hDataOffset: INTEGER;

   hLstCard: INTEGER;
   hCurCard: INTEGER;
   hCurSort: INTEGER;
   hOpnCard: INTEGER;
   hOpnSort: INTEGER;

END;

MeanRecord = RECORD { Averages of hole, nine, course, etc. } 
   tot: LONGINT; { Total strokes }
   mean: LONGINT; { Mean score — implied hundredths decimal point }
   lo: INTEGER; { Low score }
   hi: INTEGER; { High score }
   diff: LONGINT; { Par differential — implied hundredths }
  END;
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CMR09Ptr = ^CMR09; { Pointer to 9-hole course mean record }
CMR09Hdl = ^CMR09Ptr; { Handle to 9-hole course mean record }

CMR09 = RECORD { A 9-hole course mean record } 
  rA: INTEGER; { Total rounds played }
  mHole: ARRAY[kHole1..kHole9] OF MeanRecord; { Hole mean records }
  mA: MeanRecord; { Total mean record }

END;

 
CMR18Ptr = ^CMR18; { Pointer to 18-hole course mean record }
CMR18Hdl = ^CMR18Ptr; { Handle to 18-hole course mean record }

CMR18 = RECORD { An 18-hole course mean record }
   rF: INTEGER; { Total rounds — front }
   rB: INTEGER; { Total rounds — back }
   rA: INTEGER; { Total rounds — course (see notes) }
   mHole: ARRAY[kHole1..kHole18] OF MeanRecord; { Hole mean records
}
   mF: MeanRecord; { Total mean record — front }
   mB: MeanRecord; { Total mean record — back }
   mA: MeanRecord; { Total mean record — course (see notes) }

END;

DistRecord = ARRAY[kEagle1..kBogey4] OF INTEGER; { Distribution record
}

CDR09Ptr = ^CDR09; { Pointer to 9-hole course distribution record }
CDR09Hdl = ^CDR09Ptr; { Handle to 9-hole course distribution record }

CDR09 = RECORD { A 9-hole course distribution record }
   dHole: ARRAY[kHole1..kHole9] OF DistRecord; { Hole distributions
}
   dA: DistRecord; { Course distribution }

END;

CDR18Ptr = ^CDR18; { Pointer to 18-hole course distribution record }
CDR18Hdl = ^CDR18Ptr; { Handle to 18-hole course distribution record }

CDR18 = RECORD { An 18-hole course distribution record }
   dHole: ARRAY[kHole1..kHole18] OF DistRecord; { Hole distribution
}
   dF: DistRecord; { Total distribution — front }
   dB: DistRecord; { Total distribution — back }
   dA: DistRecord; { Total distribution — course }

END;

WData09Ptr = ^WData09; { Pointer to 9-hole course file }
WData09Hdl = ^WData09Ptr; { Handle to 9-hole course file }

WData09 = RECORD { A 9-hole course file }
   wDataOffset: INTEGER; { Offset, in bytes, from here to 1st 
card }
   wLstCard: INTEGER; { Number of cards in file }
   wCurCard: INTEGER; { Card currently being displayed }
   wCurSort: INTEGER; { Current sort order of file }
   wOpnCard: INTEGER; { Card displayed when file was opened/saved }
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   wOpnSort: INTEGER; { Sort order when file was opened/saved }
   wUnused3: INTEGER; { RESERVED FOR FUTURE USE }
   wUnused4: INTEGER; { RESERVED FOR FUTURE USE }
   wUnused5: INTEGER; { RESERVED FOR FUTURE USE }
   wDist: CDR09; { The course’s distribution }
   wMean: CMR09; { The course’s mean record }
   wCourse: Course09; { The course’s hole information }
   wFlags: INTEGER; { Special information — see notes }

END;

WData18Ptr = ^WData18; { Pointer to an 18-hole course file }
WData18Hdl = ^WData18Ptr; { Handle to an 18-hole course file }

WData18 = RECORD { An 18-hole course file }
   wDataOffset: INTEGER; { Offset, in bytes, from here to 1st 
card }
   wLstCard: INTEGER; { Number of cards in file }
   wCurCard: INTEGER; { Card currently being displayed }
   wCurSort: INTEGER; { Current sort order of file }
   wOpnCard: INTEGER; { Card displayed when file was opened/saved }
   wOpnSort: INTEGER; { Sort order when file was opened/saved }
   wUnused3: INTEGER; { RESERVED FOR FUTURE USE }
   wUnused4: INTEGER; { RESERVED FOR FUTURE USE }
   wUnused5: INTEGER; { RESERVED FOR FUTURE USE }
   wDist: CDR18; { The course’s distribution }
   wMean: CMR18; { The course’s mean record }
   wCourse: Course18; { The course’s hole information }
   wFlags: INTEGER; { Special information — see notes }

END;

NOTES:

Since PGSS™ lets nine-hole scores be entered on 18-hole courses, the 
rA field of a CDR18 record is somewhat superfluous since it contains 
the number of full rounds played on the course. That number is of no 
use when it comes to calculating the course scoring average for an 18-
hole course. If an 18-hole course contains scores for both the front 
and back nines, PGSS™ will figure the course scoring average by adding
the scoring averages of the front and back nines together. It reminds 
itself to do this by using the tot field of the mA record in wMean as 
a LONGINT Boolean. If an 18-hole file has scores for both the front 
and back nines wMean.mA.tot will be set to 1. If it does not, that 
field will be set to 0.

The wFlags field in both 9- and 18-hole course files contains the WIND
resource ID number for the course file. This field got a lot of use at
one time but, as the program has evolved, it’s become something of an 
artifact.

The sort fields in both 9- and 18-hole courses, wCurSort and wOpnSort,
use a special format. The low byte of those integers contains the type
of sort. It will have a value from 0 to 5. Use the following constants
to interpret that value:

kSortedByEntry = 0; kSortedByFront = 3;
kSortedByDate = 1; kSortedByBack = 4;
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kSortedByHole = 2; kSortedByTotal = 5;

If the low byte equals kSortedByHole, then read the high byte to get 
the number of the hole used for the sort. It will be a number between 
1 and 18. If the low byte is not kSortedByHole, the high byte is 
undefined.

The scorecards in a PGSS™ file are laid out end-to-end following the 
wFlags field of WData09 and WData18 records. Eighteen-hole courses use
an 18-hole card even if scores for only nine holes are recorded.
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